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Foreword

Make everything as simple as
possible, but not simpler.
      - Albert Einstein

1Foreword

© 2006 Dane Prairie Systems, LLC





Part I



Win2PDF4

© 2006 Dane Prairie Systems, LLC

1 Installing Win2PDF
1.1 Win2PDF and Win2PDF Pro

To install Win2PDF, log into your PC as an Administrator and run the Win2PDF install
program.  After you run the install program, you will have a new printer in the printers
folder named "Win2PDF".
If you are evaluating Win2PDF, you can start creating PDF documents immediately. 
The evaluation version is fully functional, but every PDF document will have an extra
trailer page with Win2PDF product information.  Also, a registration reminder dialog will
occasionally display.
The Win2PDF Pro install program can only be downloaded after you purchase the
product.  If you already have Win2PDF evaluation version installed, you do not need to
uninstall Win2PDF before running the Win2PDF Pro install program.  
If you have purchased Win2PDF, you can enter your registration code by following the
instructions in "registering Win2PDF".

1.2 Win2PDF Terminal Server Edition and Win2PDF Pro Terminal
Server Edition
To ensure that Win2PDF is installed for multi session use, the Win2PDF install program
should be run from the control panel "Add/Remove Programs".  Log in as an
administrator and open "Add/Remove Programs", and select on the "Add New
Programs" icon, and click on the "CD or floppy" button.  
The Add New Programs wizard will ask you to insert the installation floppy or CD.  You
can ignore this step and click "Next".  On the next dialog, click the "Browse" button
and select the Win2PDF install program.  After the Win2PDF install has completed, click
"Finish" to close the Add New Programs wizard.  Once Win2PDF is installed, it will be
available to all local users and all terminal server users.
If you are evaluating Win2PDF, you can start creating PDF documents immediately. 
The evaluation version is fully functional, but every PDF document will have an extra
trailer page with Win2PDF product information. 
If you have purchased Win2PDF, you can enter your registration code by following the
instructions in "registering Win2PDF".

1.3 Deploying Win2PDF
If you are deploying Win2PDF to a large number of computers (50+), Dane Prairie
Systems can create a customized version of the Win2PDF install program that will
automatically register each installed copy of Win2PDF to your company. 
The following command line options are supported by the Win2PDF install:
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/SILENT, /VERYSILENT 
Instructs Setup to be silent or very silent. When Setup is silent the wizard and the
background window are not displayed but the installation progress window is. When a
setup is very silent this installation progress window is not displayed. Everything else is
normal so for example error messages during installation are displayed and the startup
prompt is (if you haven't disabled it with the '/SP-' command line option explained
above) 
If a restart is necessary and the '/NORESTART' command isn't used (see below) and
Setup is silent, it will display a "Reboot now?" message box. If it's very silent it will
reboot without asking. 
/NORESTART 
Instructs Setup not to reboot even if it's necessary. 
If you invoke the install with the following command line, it will bypass all user
intervention, hide the progress bar, and it will not reboot even if necessary. 
   w2pdf.exe /VERYSILENT /NORESTART

The Win2PDF install only has to reboot if you are upgrading a previous installation of
Win2PDF.
/SUPPRESSWARNINGS=nowarnings
Instructs Setup to suppress Win2PDF specific warnings that can occur when installing
on terminal servers, such as the following message:
"Server operating system detected.  If you decide to purchase Win2PDF and intend on
using the product in a multi user server based application, you must purchase a server
license of Win2PDF."
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/SUPPRESSMSGBOXES 
Instructs Setup to suppress message boxes. Only has an effect when combined with '/
SILENT' and '/VERYSILENT'. 

The default response in situations where there's a choice is: 
-Yes in a 'Keep newer file?' situation. 
-No in a 'File exists, confirm overwrite.' situation.  
-Abort in Abort/Retry situations. 
-Cancel in Retry/Cancel situations. 
-Yes (=continue) in a DiskSpaceWarning/DirExists/DirDoesntExist/NoUninstallWarning/
ExitSetupMessage/ConfirmUninstall situation. 
-Yes (=restart) in a FinishedRestartMessage/UninstalledAndNeedsRestart situation. 
5 message boxes are not suppressible: 
-The About Setup message box. 
-The Exit Setup? message box. 
-The FileNotInDir2 message box displayed when Setup requires a new disk to be
inserted and the disk was not found. 
-Any (error) message box displayed before Setup (or Uninstall) could read the
command line parameters. 
-Any message box displayed by [Code] support function MsgBox. 
/LOG 
Causes Setup to create a log file in the user's TEMP directory detailing file installation
and [Run] actions taken during the installation process. This can be a helpful debugging
aid. For example, if you suspect a file isn't being replaced when you believe it should be
(or vice versa), the log file will tell you if the file was really skipped, and why.
The log file is created with a unique name based on the current date. (It will not
overwrite or append to existing files.)

The information contained in the log file is technical in nature and therefore not
intended to be understandable by end users. Nor is it designed to be machine-
parseable; the format of the file is subject to change without notice. 
/LOG="filename" 
Same as /LOG, except it allows you to specify a fixed path/filename to use for the log
file. If a file with the specified name already exists it will be overwritten. If the file
cannot be created, Setup will abort with an error message. 
/NOCANCEL 
Prevents the user from cancelling during the installation process, by disabling the
Cancel button and ignoring clicks on the close button. Useful along with '/SILENT' or '/
VERYSILENT'. 
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2 Using Win2PDF
2.1 Creating a PDF file

The Win2PDF installation creates a printer in the printers folder named Win2PDF. 
To create a PDF file:
� Open a document from a Windows application (MS-Word, Excel, Internet Explorer,

etc.)
� Print the document as you normally do but select the Win2PDF printer
� You will be prompted to enter the name of the PDF file, as shown on this screen:
 

The default file name is supplied by the sending application.  You can choose a number
of optional actions to take after the PDF file is created by selecting the check boxes. 
The options include:
� View PDF - Opens the PDF file in the default PDF viewer after the file is created.
� Print PDF - Prints the PDF to the default printer after the file is created.  This option is

only available when Win2PDF is not the Windows system default printer.
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� Send to Palm - Synchronizes the PDF file with Acrobat Reader for PalmOS.  This
option may be hidden if the Palm desktop software is not installed on the PC.  More
information on this feature is available in "Sending PDF files to a PDA".

� Send PDF - Opens a new email message using the default MAPI-compliant email client
and attaches the PDF file to the message.  The email program is specified in the
Internet Options icon in the Windows control panel.  If the Win2PDF Mail Helper
application is installed, the Mail Helper application will be opened to send the email
instead of the default MAPI client.

� Delete after Sending - Deletes the PDF file after it has been sent using the "Send
PDF" option.

You can use the file save dialog to browse to a new location before saving the PDF file. 
Win2PDF remembers this location, and will use the same location the next time you
create a PDF file.

2.2 Advanced Settings
The "PDF Options" dialog contains advanced settings for Win2PDF.

Win2PDF can automatically convert web addresses beginning with "http" and "www" to
PDF hyperlinks.  The hyperlinks are outlined in a dashed rectangle.  If you want to
disable this automatic URL detection, you can uncheck the "Enable URL detection"
check box.  The remaining settings are only used in Win2PDF Pro, and are covered in
the "Document Information" and "Document Security" sections of "Win2PDF Pro
Settings".
When the "Optimize Image File Size" option is checked, Win2PDF compresses all
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images using JPEG compression.  This results in smaller file sizes, but can reduce the
image quality of some images such as black and white scanned documents.  Turning off
this option can improve the quality of some types of images, but will also result in
larger file sizes.
An administrator can disable or set a default options for all users with the "Win2PDF
Admin Utility" available for download at:
http://win2pdf.corphelp.net/?_a=downloads

2.3 Merging to an existing PDF file
If you select a file in the file save dialog that already exists, Win2PDF will display the
following dialog:

The "Prepend" button will create a new document containing the existing PDF file and
will insert the new document information at the beginning of the file.  The "Append"
button will create a new document containing the existing PDF file and will add the new
document information to the end of the file.  The "Replace" button will overwrite the
existing PDF file, and the "Cancel" button will cancel the PDF creation without affecting
the existing PDF file.  
If the "Overwrite original file" check box is checked, the "Prepend" and "Append"
buttons will overwrite the original document with the new merged document.  This
option should be used with caution since it cannot be undone.  If the "Overwrite
original file" check box is not checked, both the "Prepend" and "Append" buttons will
display an additional dialog to choose a new file name as shown below.  In this case,
the original PDF file will not be modified.
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If you selected options to "View PDF", "Print PDF", "Send to Palm", or "Send PDF"
in the first file save dialog, they will be performed after the file has been merged.
If you enabled encryption in Win2PDF Pro, the merged file will be encrypted.  Win2PDF
cannot append or prepend to an existing PDF file that is already encrypted.

2.4 Fonts
Win2PDF supports the 14 fonts that are built into Adobe Acrobat Reader®.  These
include: 

� Courier
� Courier-Bold
� Courier-Oblique
� Courier-BoldOblique
� Helvetica
� Helvetica-Bold
� Helvetica-Oblique
� Helvetica-BoldOblique
� Times-Roman
� Times-Bold
� Times-Italic
� Times-BoldItalic
� Symbol (Symbol)
� ZapfDingbats

TrueType fonts can be configured to be substituted with one of the supported fonts,
printed as graphics, or embedded in the PDF file if the "Win2PDF Font Helper"
application is installed.  To configure the TrueType font substitution: 
Open the printers folder from Start->Settings->Printers.
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1. Right click on the Win2PDF icon.
2. Select "Properties".
3. Select the "Device Settings" tab.
4. Click on the "Font Substitution Table" item.  

5.For each font, choose the substituted font or choose "Print as Graphics".  If the
"Win2PDF Font Helper" application is installed, an option labeled "Embed Font" will
appear instead of "Print as Graphics".
TrueType fonts that use the symbol character set such as "Wingdings" are automatically
printed as graphics.  Printing fonts as graphics can significantly increase the size of the
PDF file, so this feature should be used with care.  Downloadable Type 1 Postscript fonts
are not supported.  
TrueType fonts that are printed as graphics can look more "bold" than the original font.
 To improve the appearance of these fonts, you can change smoothing preferences in 
Acrobat Reader 5.0 by opening the Edit->Preferences->Display dialog and enabling
the "smooth line art" option.  This option is not available in Acrobat Reader 4.0.
Win2PDF will automatically stretch or squeeze the substituted font to match the original
font.  In some types of documents, the PDF file may look better when each character is
placed to match the original font.  You can enable this by changing the "Font
Substitution" from "Normal" to "Slow but more accurate".  This option can improve
the quality of documents that contain full justification.
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Changing the font substitution to "Slow but more accurate" may increase the PDF file
size.

2.5 Font Helper Application
The Win2PDF Font Helper is an optional, stand-alone application that can assist
Win2PDF in embedding TrueType fonts in a PDF file.  When TrueType fonts are
embedded in the PDF file, they will always display the same regardless of the fonts
available on the computer used to view the PDF file.  Embedding TrueType fonts will
increase the size of the PDF file.
The Win2PDF Font Helper application can be downloaded from the downloads section of
the Win2PDF support web site.  When you install the Win2PDF Font Helper application,
it automatically configures Win2PDF to embed fonts that are not internally supported by
Adobe Reader.  You can manually configure which fonts are embedded and substituted
in the font substitution table.  The Font Helper application is only supported in Win2PDF
version 2.85 or higher.  The Font Helper changes the way that the PDF file is created,
and may help other graphics related problems in PDF files.  Only Western character sets
are currently supported by the Font Helper.
The Font Helper application can be uninstalled from the Control Panel "Add/Remove
Programs".  Win2PDF will continue to work if the Font Helper application is uninstalled,
but the "Embed Font" option will not be available in the font substitution table.

2.6 Paper Sizes
Win2PDF supports the following paper sizes:
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� US Letter
� US Legal
� 4A0
� 2A0
� A0
� A1
� A2
� A3
� A4
� B5
� US Letter Small
� A4 Small
� US Legal Small
� Tabloid 11x17in.
� A-Size 8.5x11in.
� B-Size 11x17in.
� C-Size 17x22in.
� D-Size 22x34in.
� E-Size 34x44in.
� Arch-A 9x12in.
� Arch-B 12x18in.
� Arch-C 18x24in.
� Arch-D 24x36in.
� Arch-E 36x48in.

In addition, Win2PDF supports user defined custom page sizes.  To create a custom
page size:
1.  Open the printers folder
2.  Under the "File" menu, select "Server Properties".
3.  Select the "Forms" tab.
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4.  Check the "Create a New Form" box, and fill out the "Form Description" and "
Paper Size" fields.  It is best to leave the "Printer Area Margins" fields as 0.
5.  Select "Save Form" and close the dialog.  Your form should now be available to
Win2PDF.

2.7 Application Settings Vs. Default Settings
Many applications have the ability to change the printer settings from the print dialog or
from a page setup dialog.  If you change a setting from an application, it will not
change the default setting.  
To change the default printer setting, you need to change the setting in the "Printing
Preferences" (Windows 2000,XP) or "Document Defaults" (Windows NT) dialogs.
You can find these dialogs by opening the printers folder, right clicking on the
"Win2PDF" icon, and choosing "Printing Preferences" or "Document Defaults".

2.8 Resolution
The default resolution for bitmaps is 120 DPI.  You can change the default resolution by
opening the printers folder, right clicking on the Win2PDF icon, and opening "Printing
Preferences" (Windows 2000,XP) or "Document Defaults" (Windows NT).  The
resolution setting us under the "Advanced" section of this dialog.
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Increasing the resolution will improve the quality of bitmap images, but it will also
increase the PDF file size.

2.9 Sending PDF files to a PDA
PDF files created with Win2PDF can be viewed on any type of computer that has a PDF
viewer including PalmOS and Pocket PC devices.
The "send to palm" option in the Win2PDF file save dialog launches Acrobat Reader for
PalmOS which converts the PDF file to a format that is readable by the PalmOS.  The
converted file is automatically downloaded to the Palm when you synchronize.  The
location of the converted file is controlled by Acrobat Reader for PalmOS, and the
original PDF file remains intact.
Acrobat Reader for the Pocket PC does not have the same synchronization options, but
you can easily download PDF files to a Pocket PC device by enabling file
synchronization.  This will create a folder on your Windows desktop (e.g. "Pocket_PC
My Documents").  To download a PDF file, just save the PDF file to the file
synchronization folder and synchronize your Pocket PC.
Acrobat Reader for PalmOS and Pocket PC devices uses "tagged" PDF files so that the
files can be reformatted for the smaller screens.  Win2PDF does not support creating
"tagged" PDF files, but Acrobat Reader for PalmOS and Pocket PC will automatically
convert the PDF files to a tagged format when they are downloaded.
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2.10 Win2PDF Pro Settings
2.10.1 Document Information

Win2PDF Pro can set the document information such as Title, Author, Subject, and
Keywords.  This information is entered in the "PDF Options..." dialog of the Win2PDF
File Save dialog.  

The "Author" and "Keywords" fields are saved by Win2PDF and applied to all
subsequent documents.  The default value for the "Title" field is set by the application.
The "Subject" field is not saved for future documents, and must be manually set for
each document.
The document information can be viewed in Acrobat Reader by opening File-
>Document Properties->Summary



Win2PDF18

© 2006 Dane Prairie Systems, LLC

Information on controlling the document information from a custom application is
available in "Setting Document Information" in the developer information section.

2.10.2 Document Security
Win2PDF Pro supports the standard security options and permissions available in the
PDF file format.
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The "Encryption Level" setting controls the type of encryption used in the PDF file.
The 40 bit encryption is compatible with Acrobat Reader 4.0 and above and the 128 bit
encryption is compatible with Acrobat Reader 5.0 and above.  For best security, the 128
bit encryption option is recommended.
The "Permissions" setting controls restrictions that can be placed on the PDF file.  To
prevent printing of a PDF file, uncheck the "Allow the document to be printed"
option.  To prevent the text and graphics from being copied from the PDF file, uncheck
the "Allow text and graphics to be copied" option.  To prevent the document from
being modified in a PDF editor, uncheck the "Allow the document to be modified"
option.  
The PDF file format allows two types of passwords, a user password and a master
password.  The user password is used to open the document, and the master password
used to encrypt the security options.  When a user password is set, Acrobat Reader
displays the following prompt when you open the PDF file.

You must always enter a master password when security options are enabled.  It is
recommended that passwords be at least 8 characters long and contain at least 1
number.
The password and permissions options are only available when the "Encryption Level"
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is set to 40 or 128 bit encryption.
Information on controlling the encryption options from a custom application is available
in "controlling encryption options" in the developer information section.
An administrator can disable or change the default value for any of the security settings
using the "Win2PDF Admin Utility" available for download at:
http://win2pdf.corphelp.net/?_a=downloads

2.10.3 Applying a watermark
Win2PDF Pro can overlay an existing PDF file on newly created PDF files (Add a
Watermark) or place and existing PDF file behind text and graphics on newly created
PDF files (Add a Background).  The existing watermark or background PDF file can
contain any text or graphics, but it most often used to apply a "confidential" or "draft"
stamp on each page of a document.  To enable the watermark or background feature,
select the "Add a Watermark" or "Add a Background" option in the Win2PDF "PDF
Options" dialog.

When the watermark or background options are enabled, a text box containing the
name of the current watermark or background PDF file is shown below the options.  If
you would like to change the file, click the "Change..." button and select a new
watermark or background PDF file.  Win2PDF will always display the last used
watermark or background PDF file when the feature is enabled.
If the watermark or background PDF file contains more than one page, only the first
page will be applied to each page of the new document.  It's best to use a watermark or
background PDF file that has the same page size as the newly created PDF file.  If the
watermark or background file has a different page size, it will be scaled and centered on
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the page of the newly created PDF file.
You can create the watermark or background PDF file using Win2PDF and any Windows
application such as Microsoft Word.  If you are using Win2PDF Pro, the watermark or
background PDF file must not be encrypted.  Some sample watermark and background
PDF files and the corresponding Word documents are available on the download section
of the support web site at:
http://www.win2pdf.com/download/download.htm
Information on controlling the watermark options from a custom application is available
in "watermark options" in the developer information section.
An administrator can disable or set a default watermark PDF file for all users with the "
Win2PDF Admin Utility" available for download at:
http://www.win2pdf.com/download/download.htm

2.11 Application Notes
2.11.1 Microsoft Word

Print to the Win2PDF printer as normal. Do not check the "print to file" check box in
the Microsoft Word print dialog.
Win2PDF cannot convert the Word document table of contents to PDF bookmarks. 
Win2PDF can convert URLs beginning with "http" or "www" to PDF hyperlinks, but it
cannot convert embedded hyperlinks to PDF hyperlinks.

2.11.2 Microsoft Excel
If you are creating a PDF file from an Excel workbook that contains multiple worksheets,
selecting the "Entire workbook" option from the Excel print dialog will create a
separate PDF file for each worksheet.  If you would like to have all worksheets in a
single PDF file, you can select multiple worksheets before printing to the Win2PDF
printer.
You can select multiple worksheets by holding down the "shift" or "control" key while
clicking on the sheet tab.  Select the "Print..." command from the "File" menu and
make sure "Active sheet(s)" is enabled in the Excel print dialog.  More information on
selecting multiple worksheets is available at:
http://office.microsoft.com/en-us/assistance/HP052024921033.aspx
Alternatively, if you select "print to file" from the Excel print dialog all worksheets will
be created in a single PDF file.

2.11.3 AutoCad
In AutoCAD 2002, plot to a PDF as follows :

Command 'PLOT'.
� Select 'Plot Device' Tab.
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� In the 'Plotter Configuration' frame, click the 'Properties...' button.
 
� A new dialog box opens.

� Select 'Device and Document Settings' tab.

� If necessary highlight 'Custom Properties' in the tree.

� Click the 'Custom Properties' button.
 
� A new dialog box opens.

� Select the 'Paper Orientation' (Note A).

� Click the 'Advanced...' button.
 
� A new dialog box opens.

� Highlight 'Paper Size' in the tree.

� Select the paper size from the drop-down list. This is an important step. (Note B)
 
� Click 'OK' 3 times to close the dialog boxes and save to a .pc3 file if necessary.

 
� Back in the AutoCAD plot dialog, select the 'Plot Settings' tab. In the 'Paper

Size...' frame the paper size should have changed to the value set earlier at (Note
B). Do not change the paper size here as this may produce inconsistent rotations,
sizes and offsets. In the 'Drawing Orientation' frame select 'Portrait' or '
Landscape'. Note that this orientation selection overrides orientations that were
set at (Note A) or (Note B). 

� Click 'OK' to plot.
 

2.11.4 Internet Explorer
Win2PDF can convert web pages to PDF files by printing them in Internet Explorer.  By
default, Internet Explorer prints the web page title and the page number at the top of
each page and the web page URL at the bottom of each page.  You can change these
settings in the Internet Explorer page setup dialog.
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The available options for the Internet Explorer header and footer follow.
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3 Purchasing Win2PDF
3.1 Online

You can purchase Win2PDF online at the http://www.win2pdf.com web site.  We accept
all major credit cards (Visa, MasterCard, American Express, Discover, Diners Club) and
use secure credit card processing services provided by Digital River.

Digital River also accepts checks, and credit card payment by fax or telephone.
After you have purchased Win2PDF, you will receive an e-mail receipt containing a
registration code.  You enter this registration code as described in "Registering Win2PDF
" to remove the extra page from each document.
If you are purchasing Win2PDF Pro, you will receive a link to download the Win2PDF Pro
setup program as part of your e-mail receipt.

3.2 Purchase Orders
Purchase orders can be faxed to (612) 435-4926.  
For sales inquiries, send e-mail to sales@win2pdf.com
Our mailing address is:

Dane Prairie Systems, LLC
P.O. Box 24491
Minneapolis, MN, USA 55424-0491
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3.3 Registering Win2PDF
After you have received a registration code through e-mail, you can register Win2PDF
by running 
"Start->Programs->Win2PDF->Enter Win2PDF License".  The following dialog will
appear.

Click on the "Enter registration code" button, and enter your name, company, and
registration code exactly as they are listed in your e-mail receipt.
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If you entered the information correctly, you should see a success message as follows.

The PDF documents created by Win2PDF will no longer include the trailer page on each
document.



Part IV
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4 Frequently Asked Questions
4.1 Win2PDF FAQ on the Internet

The latest Win2PDF frequently asked questions list is available on the win2pdf.com web
site.  If your question is not answered here, you may submit a question from this site.

4.2 Does Win2PDF support Windows 95/98/ME?
Win2PDF does not support Windows 95/98/ME.  
Win2PDF installs as a print driver, and this print driver only works with Windows NT,
Windows 2000, and Windows XP, Microsoft's replacement for Windows ME.

4.3 What type of fonts does Win2PDF support?
Win2PDF supports the 14 fonts that are built into Adobe Acrobat Reader®.  These
include: 

� Courier
� Courier-Bold
� Courier-Oblique
� Courier-BoldOblique
� Helvetica
� Helvetica-Bold
� Helvetica-Oblique
� Helvetica-BoldOblique
� Times-Roman
� Times-Bold
� Times-Italic
� Times-BoldItalic
� Symbol
� ZapfDingbats

TrueType fonts can be configured to be substituted with one of the supported fonts,
printed as graphics, or embedded if the Win2PDF Font Helper application is installed.
The "Fonts" section of "Using Win2PDF" describes how to configure font substitution.

4.4 I'm a noncommercial user.  How do I remove the extra page from
each document?
Win2PDF is free for noncommercial use, but you must purchase the software to remove
the extra page from each document.

4.5 How can I control the PDF file name without prompting?
There are three options:

� If the output PDF file can always have the same name, you can create a Windows port
that specifies the name.  To create a file name port:
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1.  Open the printers folder under Start>Settings>Printers.

2.  Right click on Win2PDF and select "Properties".

3.  Select the "Ports" tab.

4.  Click on the "Add Port..." button.

5.  Under "Available Printer Ports" select "Local Port" and then click the "New
Port" button.

6.  Under "Enter a port name:" type in the full path name to the PDF file that you
would like to be created.  For example, you could type "c:\my.pdf"  Click OK.

7.  You should be back at the "Ports" tab of the "Properties" dialog.  The file name
that you entered in step 6 should display under "port."  Click the check box for the
port filename, and then click "OK" or "Apply".

Printing to Win2PDF will now create a PDF file using the name that you picked without
prompting.

� You can use the registry as documented in the "Developer Information" section under
"Specifying an output file name".

� You can use the Win32 API as documented in the "Developer Information section
under "Windows Printer Interface".

4.6 Does Win2PDF support user defined page sizes?  How can I add a
custom page size to Win2PDF?
The "Paper Sizes" section of "Using Win2PDF" describes how to add a custom page size.

4.7 Does Win2PDF support compression?
Yes.  Win2PDF supports "flate" compression of all page objects and "JPEG" compression
for color bitmaps.

4.8 How can I improve the quality of bitmap images?
You can increase the default resolution to improve the quality of bitmap images.  To do
this, open the printers folder, right click on the Win2PDF icon, and select "Document
Defaults" (Windows NT) or "Printing Preferences" (Windows 2000/XP).  You can increase
the default resolution under the "Advanced" tab to improve the bitmap quality but this
will also increase the PDF file size.
For more information, see "Resolution".
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4.9 Does Win2PDF create PDF files that are optimized for web
downloading?
PDF files created with Win2PDF can be used on web pages, but they are not linearized
PDF files. 

4.10 Does Win2PDF support bookmarks?
This feature is not supported by Win2PDF, but is under consideration for future versions
of the product.  

4.11 Can Win2PDF be used on a web server?
Usage on a server requires a server license of Win2PDF.  For an example of Win2PDF on
a web server, see the demo from the North Coast Idea Company at http://www.ncidea.
com/w4form.asp.  Information on using a printer from a web server from the Microsoft
knowledge base is at:

http://support.microsoft.com/support/kb/articles/q184/2/91.asp
4.12 Is it possible to print multiple worksheets in a single Excel

workbook to a single .pdf file?
Select the worksheets that you want to print by holding down the "shift" or "control"
key while clicking on the sheet tab.  Select the "Print..." command from the "File"
menu and make sure "Active sheet(s)" is enabled in the Excel print dialog.  More
information on selecting multiple worksheets is available at:
http://office.microsoft.com/en-us/assistance/HP052024921033.aspx
Alternatively, if you select "print to file" from the Excel print dialog all worksheets will
be created in a single PDF file.

4.13 Does Win2PDF support Asian character sets?
Asian characters are supported but are rendered using the "print as graphics" feature of
Win2PDF.

4.14 Is it legal to create PDF files with Win2PDF?
Yes.  Adobe Systems Inc. created the PDF file format and owns the copyrights on the
data structures, operators, and written specification for PDF.  Adobe wishes to make
PDF an open standard, so they have given permission to anyone to write software that
creates PDF files.  The have also given royalty free licenses to the patents if used to
create PDF files.  Information on this policy is in section 1.7 of the PDF specification
published by Adobe, and also at http://partners.adobe.com/public/developer/support/
topic_legal_notices.html.

4.15 Can Win2PDF append to an existing PDF file?
Yes, see "Merging to an existing PDF file".
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4.16 When installing Win2PDF, I'm get the error message "AddPrinter
error 126."
This error can occur if either of the following conditions is true:

� The %SYSTEMROOT%\System32\Wbem\framedyn.dll file is missing or damaged.
-or- 
� The Windows Path environment variable does not point to the %SYSTEMROOT%

\System32\Wbem folder. 
To correct the problem, use one of the following methods:

Run the Windows system file checker
The Windows system file checker will scan all protected Windows files and verify their
versions.  If it detects any files that have been replaced or damaged, it will repair the
files.  To run the system file checker:
1. Click Start, and then click Run.
2. In the Open box, type sfc /scannow and then click OK.
More information on the Windows system file checker is available at the following
location:
http://support.microsoft.com/?kbid=310747

Replace the Framedyn.dll File
1. Click Start, and then click Run.
2. In the Open box, type %systemroot%\system32\dllcache, and then click OK

.
3. Right-click framedyn.dll, and then click Copy on the shortcut menu that

appears.
4. Click Start, and then click Run.
5. In the Open box, type %systemroot%\system32\wbem, and then click OK.
6. On the Edit menu, click Paste. If you are prompted to replace the existing file,

click Yes.

Verify System Variables
1. Click Start, right-click My Computer, and then click Properties on the shortcut

menu that appears. If you receive the following error message, click OK: 
rundll32.exe - Unable To Locate Component  This application has failed to
start because framedyn.dll was not found. Re-installing the application may fix
this problem. 

2. In the System Properties dialog box, click the Advanced tab.
3. Click Environment Variables.
4. Under System variables, click Path, and then click Edit.  NOTE: If no Path

variable is listed, click New. In the Variable name box, type Path.
5. In the Variable value box, type the following:  %SystemRoot%\system32;%

SystemRoot%;%SystemRoot%\System32\wbem
6. Click OK three times (each time that you have the option).
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More information on this problem is at the following location:
http://support.microsoft.com/default.aspx?scid=kb;en-us;319114



Part V
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5 Developer Information
5.1 Windows Printer Interface

Win2PDF interfaces with an application using standard Windows printer APIs. 
Whenever possible, Win2PDF uses standard Windows APIs instead of defining new
interfaces.  
If you are a software developer and are developing an application that uses Win2PDF,
you can also control the output filename using the standard Win32 API. To specify the
file name you need to use the Microsoft defined DOCINFO structure and the StartDoc
function. Set the lpszOutput field of the DOCINFO structure to the fully qualified path
name of the file, and then pass the DOCINFO structure to the Win32 StartDoc
function. Using this method, each file can be created using a unique name.
You can control the orientation, resolution, and other settings using the Win32 API and
the DEVMODE structure as defined in the Microsoft Platform SDK.  The Microsoft
Knowledgebase article Q167345 available at:
http://support.microsoft.com/default.aspx?scid=kb;EN-US;Q167345
describes how to change printer settings using the Win32 API.

5.2 Using the registry
5.2.1 Registry Overview

Win2PDF looks for registry values at the following locations and in the following order: 
"HKEY_CURRENT_USER\Software\VB and VBA Program Settings\Dane Prairie Systems
\Win2PDF" 
"HKEY_CURRENT_USER\Software\Dane Prairie Systems\Win2PDF" and 
"HKEY_LOCAL_MACHINE\Software\Dane Prairie Systems\Win2PDF" 

The first registry location is used for the Visual Basic "SaveSetting" function.  From
Visual Basic, you can call SaveSetting with the following parameters to control
Win2PDF:
SaveSetting "Dane Prairie Systems", "Win2PDF", Value Name, Value

Where "ValueName" and "Value" will depend on the Win2PDF setting to control.  The
SaveSetting command only works with Win2PDF registry settings that use a string
type.
The HKEY_CURRENT_USER registry location is useful if you want the setting to apply
only to the current user.  This is especially important when using Win2PDF in a multi-
user environment such as Windows Terminal Services.
The HKEY_LOCAL_MACHINE location is useful if you want the setting to apply to all
users, or if your application is only going to be used with a single user.
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After the PDF file is created, the registry value will be deleted by Win2PDF.  If you
would like the setting to apply to all documents without having to add the registry value
for each document, you can create a non-zero registry value named "persistent" to
one of the locations listed above.  This will prevent Win2PDF from deleting the value
after each document.
The following Win2PDF settings can be controlled from the registry:

Value
Name

Ty
pe

Description

PDFFileName Str
ing

Controls the output file name

PDFPostFileN
ame

Str
ing

Same as PDFFileName, but is deleted after the document has been
created

persistent Dw
ord

Prevents registry values from being deleted when it is set to a non-
zero value

PDFTitle Str
ing

Sets the document title

PDFAuthor Str
ing

Sets the document author

PDFSubject Str
ing

Sets the document subject

PDFKeyword
s

Str
ing

Sets the document keywords

file options Dw
ord

Enables encryption, e-mail, view, and print PDF options

disabled
options

Dw
ord

Disables options from the file save dialog

Post Action Str
ing

Automatically executes the application specified after PDF creation.

user
password

Str
ing

Sets the user password (Win2PDF Pro)

master
password

Str
ing

Sets the master password (Win2PDF Pro)

PDFMailRecip
ients

Str
ing

Sets the email "To:"recipient addresses when the "Send PDF" option is
enabled

PDFMailCCRe
cipients

Str
ing

Sets the email "CC:" recipient addresses when the "Send PDF" option
is enabled

PDFMailSubj
ect

Str
ing

Sets the email subject when the "Send PDF" option is enabled

PDFMailNote Str
ing

Sets the email body text when the "Send PDF" option is enabled

PDFMailResol
veNames

Str
ing

Verifies email addresses using the default address book

PDFWaterma
rkFile

Str
ing

Sets the watermark PDF file

PDFDefaultW
atermarkFile

Str
ing

Sets the default watermark PDF file for all users.
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PDFExclude
WatermarkPr
e

Dw
ord

Prevents the watermark from being applied to the first number of
pages of a document.

PDFExclude
WatermarkP
ost

Dw
ord

Prevents the watermark from being applied to the last number of
pages of a document.

If you create the any of the string registry values as a REG_EXPAND_SZ instead of a
REG_SZ type, the value will be expanded from environment variables.  The
environment variables are specified with "%" characters at the beginning and end of the
variables as in "%HOMEPATH%".  The REG_EXPAND_SZ option is not available from the
Visual Basic SaveSetting command.  The %DATE% and %TIME% environment variables
are not expanded by this option.
The registry methods are not safe when used with programs that have multiple threads
or multiple processes that access Win2PDF.  For these types of programs, you need to
ensure that only one thread or process has access to Win2PDF at a time by using a
Windows critical section or mutex.  The Windows printer interfaces do not have these
limitations.
When multiple instances of Win2PDF are installed, Win2PDF first looks in the registry
locations based on the instance name of Win2PDF.  This allows separate settings for
different instance of Win2PDF.  For example, if the current instance of Win2PDF is
named "Win2PDF (Copy 1)" the following registry locations would be checked before the
standard registry locations:
"HKEY_CURRENT_USER\Software\VB and VBA Program Settings\Dane Prairie Systems
\Win2PDF (Copy 1)" 
"HKEY_CURRENT_USER\Software\Dane Prairie Systems\Win2PDF (Copy 1)" and 
"HKEY_LOCAL_MACHINE\Software\Dane Prairie Systems\Win2PDF (Copy 1)" 

If a setting doesn't exist under the instance name section of the registry, then Win2PDF
checks the standard locations.

5.2.2 Specifying an output file name
In addition to being able to control the output file using the Win32 API, you can control
the output file name by creating a string value in the registry at any of the standard
registry locations.  The "PDFFileName" value should be set to the full path name of the
PDF file.   If the "PDFFileName" entry does not exist in the registry, the user will be
prompted to enter a file name.
From Visual Basic, you can set the output file name using the following code sample: 
SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", filename 

Where the filename parameter is the full path name for the PDF file. By default, the "
PDFFileName" entry is removed from the registry after each PDF file is created and
you must add the "PDFFileName" each time you print.  If you want to prevent the "
PDFFileName" from being removed after each document, you can create a DWord
value named "persistent" at one of the standard registry locations.
If a PDF file already exists at the location specified by "PDFFileName", it will be
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overwritten.  If you want to prevent files from being overwritten, you can add a single
asterisk character "*" to the file name to specify a wildcard.  If a wildcard character
exists, it will be replaced by a sequential number so that PDF files are never
overwritten.
If you want to create a unique PDF file name, you can use a single "%" character in the
file name.  The "%" character will be expanded to include a sequence of numbers based
on the current date and time.
If you create the "PDFFileName" registry value as a REG_EXPAND_SZ instead of a
REG_SZ type, the file name will be expanded from environment variables. The
environment variables are specified with "%" characters at the beginning and end of the
variables as in "%HOMEPATH%". If the environment variable does not exist, the first
"%" character will be expanded by a sequences of numbers based on the date and time
as described previously. The REG_EXPAND_SZ option is not available from the Visual
Basic SaveSetting command. The %DATE% and %TIME% environment variables are
not expanded by this option. 
Win2PDF sets the current PDF document title in an environment variable named "
PDFTitle".  You can use this in combination with a REG_EXPAND_SZ environment
variable to set the file name to the document title.  For example, if a "PDFFileName"
entry with a REG_EXPAND_SZ type is set to "c:\%PDFTitle%*.pdf", Win2PDF will create
a PDF file using the document specified title without displaying a file save dialog and it
will never overwrite an existing file.
If the application needs to determine when Win2PDF has finished creating the PDF file,
it can use "PDFPostFileName" instead of "PDFFileName".  The behavior of "
PDFPostFileName" is identical to "PDFFileName" except the registry value is not
deleted by Win2PDF until the PDF file has been created.  The application can monitor
the existence of this registry value to determine if Win2PDF is still processing the PDF
file.
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5.2.3 Merge Options
You can prepend or append and existing file with the newly created file by creating a
string value in the registry at any of the standard registry locations.  If you would like
to add an existing PDF file to the beginning of the newly created file, you can create a
string value named "PDFPrependFile" and set it to the full path of the existing PDF
file.  If you would like to append an existing PDF file to the newly created file, you can
create a string value named "PDFAppendFile" and set it to the full path of the existing
PDF file.  You can specify both a "PDFPrependFile" and a "PDFAppendFile" at the
same time, and both options are only used if the output file name was specified by
using "PDFFileName".
For example, if you have an existing PDF file named "file1.pdf" and you would like to
create a new PDF file named "file2.pdf" with the contents of "file1.pdf" at the beginning
of the new file, you would set "PDFPrependFile" to file1.pdf and "PDFFileName" to
"file2.pdf".  Alternatively, if you wanted to the contents of "file1.pdf" to be at the end of
the new file, you would set "PDFAppendFile" to "file1.pdf" and "PDFFileName" to
"file2.pdf".
By default, the "PDFPrependFile" and "PDFAppendFile" entries are removed from the
registry after each PDF file is created and you must add the values each time you print.
If you want to prevent the values from being removed after each document, you can
create a DWord value named "persistent" at one of the standard registry locations.

5.2.4 Setting Document Information
You can set the PDF document subject, title, author, and keywords by creating string
values named PDFSubject, PDFTitle, PDFAuthor, and PDFKeywords in the registry
at any of the standard registry locations.  These are the same values as described in
the Document Information.  All values are deleted after each document is created
unless the "persistent" registry value is set.
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5.2.5 Enabling encryption, e-mail, view, and print PDF Options
You can create a DWORD value in the registry at any of the standard registry locations
to control actions to be taken after the PDF file is created.  The value is named "file
options", and its value can be a combination of the following values:
                        
Action value
Send email 0x01
View PDF 0x02
Send to palm 0x04
Set 40 bit encryption 0x08 (Win2PDF Pro)
Set 128 bit encryption 0x10 (Win2PDF Pro)
Enable URL detection 0x20
Delete email 0x40
Print PDF 0x80
Apply foreground watermark 0x200   (Win2PDF Pro)
Send email - no user interaction  0x400  (requires Win2PDF Mail Helper application)
Apply background watermark 0x800 (Win2PDF Pro)

The values can be added together, so if you wanted to send e-mail, enable URL
detection, and delete the file after sending you would set "file options" to 0x61
hexadecimal.  The 40 and 128 bit encryption options are only valid for Win2PDF Pro.  All
values are deleted after each document is created unless the "persistent" registry
value is set.

5.2.6 Setting E-mail Options
When the "Send email" or "Send email - no user interaction" options are enabled, you
can set the email address by creating a string value in one of the standard registry
locations named "PDFMailRecipients".  The value can be a single email address in the
form "someone@somedomain.com", or multiple recipients separated by semicolon ';' or
comma ',' characters.  You can also set one or more "CC:" email addresses by setting a
string value named "PDFMailCCRecipients" in one of the standard registry locations.
Some email clients require a "SMTP:" string in front of the address such as "SMTP:
someone@somedomain.com".  
Win2PDF can verify the addresses using the default address book if a DWORD value
named "PDFMailResolveNames" is set to 1 in one of the standard registry locations.
This can improve the reliability of sent email, but may cause the email client to display
a warning dialog.
You can set the e-mail subject field by creating a string value named "PDFMailSubject
", and you can fill in the body text of the message by creating a string value named "
PDFMailNote".  All values are deleted after each document is created unless the "
persistent" registry value is set.
Windows MAPI email clients such as Microsoft Outlook or Outlook Express will not let
you send email without user interaction.  The Win2PDF Mail Helper Application is an
optional SMTP mail client that integrates with Win2PDF and supports sending email
without user interaction.  
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5.2.7 Controlling Encryption Options
To set the security permissions, you can create a DWORD value named "security
permissions" at any of the standard registry locations.  
The DWORD value must be named "security permissions", and the value is defined by
Adobe in the PDF specification available from: http://partners.adobe.com/asn/tech/pdf/
specifications.jsp
The following table from this specification defines the privileges:

Bit Position Meaning
1-2 Reserved; must be 0
3 Print document
4 Modify contents of document (other than text annotations and

interactive form fields
5 Copy text and graphics from document
6 Add or modify text annotations and interactive form fields
7-8 Reserved; must be 1
9 Fill in existing form fields
10 Extract text and graphics for Accessibility
11 Assemble the document 
12 Allow high resolution printing 
13-32 Reserved; must be 1

The default value is 0xfffffffc.  For example, to create a PDF document that doesn't
allow printing you need to set bit position 3 to a 0 so you would set the "security
permissions" to 0xfffffff8.

The following table lists common combinations of security permissions:
Disable printing                        0xfffffff8
Disable copying                         0xffffffec
Disable modifying                       0xfffffff4
Disable printing & copying              0xffffffe8
Disable printing & modifying            0xfffffff0
Disable copying & modifying             0xffffffe4
Disable printing & copying & modifying  0xffffffe0

You can set passwords by creating String values named "user password" or "master
password" to password protect documents.  The passwords are only used if encryption
is enabled in the "file options" setting.  All registry values are deleted after each
document unless the  persistent value is set.
The security permissions and passwords are only valid for Win2PDF Pro.

5.2.8 Disabling File Save Options
The file save options such as "View PDF", "Print PDF", and "Send PDF" can be disabled
by adding a DWORD value to the registry named "disabled options" at any of the 
standard registry locations.  The options are specified using the same table as the "file
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options".  The values can be added together, so if you wanted to disable the "send
PDF" and "delete after sending" options you would set "disabled options" to 0x41
hexadecimal.  

All values are deleted after each document is created unless the "persistent" registry
value is set.

5.2.9 Automatically Executing an Application
You can automatically execute an application after the PDF file is created by creating a
string registry value named "Post Action" in any of the standard registry locations.
The application must be specified using the full path name, and the PDF file can be
passed to the application by using a "%s" in the command line.  For example, setting "
Post Action" to:
  C:\Program Files\Adobe\Acrobat 6.0\Reader\acrord32.exe "%s"
would launch Acrobat Reader after the PDF file is created.  It is important to enclose the
file name with quotation marks since the file may contain spaces.  The registry value is
deleted after each document unless the persistent value is set.

5.2.10 Watermark Options
When the "Apply foreground watermark" or "Apply background watermark" options are
enabled, the watermark PDF file can be specified by setting a string value named "
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PDFWatermarkFile" in the registry at any of the standard registry locations.  
By default, the watermark is applied to all pages in the newly created document.  If you
want to exclude the watermark from being applied to the beginning of the document,
you can set a DWORD value in the registry named "PDFExcludeWatermarkPre" to the
number of pages to exclude.  If you want to exclude the watermark from being applied
to the end of the document, you can set a DWORD value in the registry named "
PDFExcludeWatermarkPost" to the number of pages to exclude.
The registry value is deleted after each document is created unless the "persistent"
registry value is set.
A default watermark for all users can be specified by setting a string value named "
PDFDefaultWatermarkFile" at:
"HKEY_LOCAL_MACHINE\Software\Dane Prairie Systems\Win2PDF"
This registry setting is not deleted after each document.

5.2.11 Mail Helper Application
The Win2PDF Mail Helper application is an optional SMTP mail client that integrates with
Win2PDF and supports sending email without user interaction.  This application can be
downloaded from the Win2PDF support download site at: 
http://win2pdf.corphelp.net/?_a=downloads 
To email without user interaction, you must have the Win2PDF Mail Helper application
installed and configured, you must set the email recipient address,  and you must
enable the "Send email - no user interaction" option. 
The Win2PDF Mail Helper uses SMTP to send email, and requires configuration to use an
SMTP server.  You can use the "Configure Win2PDF Mail Helper" menu option to
interactively set the server settings, or you can use the following registry settings in
any of the standard registry locations:
Value
Name

Typ
e

Description
PDFMailFro
m

Strin
g

Used to fill in the "from:" field in the email header.
PDFMailServ
erName

Strin
g

SMTP server name
PDFMailUser
Name

Strin
g

If authentication is used, the user name for the SMTP server.
PDFMailPass
word

Strin
g

If authentication is used, the password for the SMTP server.
PDFMailAuth
entication

Strin
g

1 if authentication is used by the SMTP server, 0 otherwise
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5.3 Programming Environments
5.3.1 Visual Basic 6.0
5.3.1.1 Using the Printer object

The Visual Basic printer object greatly simplifies sending output to a printer.  The
following is a very simple example of creating a PDF and specifying the output file
name.
Private Sub Command1_Click()
    'set the output file name
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:\TEST.PDF"
    'output some text
    Printer.Print "hello world!"
    'save the PDF file
    Printer.EndDoc
End Sub

Win2PDF supports all of the standard Printer object methods and properties.  A more
advanced example requires some support routines for writing a Dword value to the
registry.  The following code must be added to the declarations section of the sample
form.
Option Explicit
Private Const REG_DWORD As Long = 4
Private Const HKEY_CURRENT_USER = &H80000001
Private Const KEY_ALL_ACCESS = &H3F
Private Declare Function RegCloseKey Lib "advapi32.dll" _
                       (ByVal hKey As Long) As Long
Private Declare Function RegOpenKeyEx Lib "advapi32.dll" Alias _
      "RegOpenKeyExA" (ByVal hKey As Long, ByVal lpSubKey As String, _
      ByVal ulOptions As Long, ByVal samDesired As Long, phkResult As _
      Long) As Long
Private Declare Function RegSetValueExLong Lib "advapi32.dll" Alias _
      "RegSetValueExA" (ByVal hKey As Long, ByVal lpValueName As String, _
      ByVal Reserved As Long, ByVal dwType As Long, lpValue As Long, _
      ByVal cbData As Long) As Long
Private Sub SaveWin2PDFDword(sValueName As String, lValueSetting As Long)
    Dim lRetVal As Long         'result of the SetValueExLong function
    Dim hKey As Long            'handle of open key
    lRetVal = RegOpenKeyEx(HKEY_CURRENT_USER, "Software\VB and VBA Program
Settings\Dane Prairie Systems\Win2PDF", 0, _
                            KEY_ALL_ACCESS, hKey)
    lRetVal = RegSetValueExLong(hKey, sValueName, 0&, _
                            REG_DWORD, lValueSetting, 4)
    RegCloseKey (hKey)
End Sub

Now we can use the subroutine to save a Dword value to the registry and enable 128
bit encryption.  The encryption options are only valid for Win2PDF Pro.
    
Private Sub Command1_Click()
    'set the output file name
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:\TEST.PDF"
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    'enable 128 bit encryption (Win2PDF Pro only) and automatic url detection
    SaveWin2PDFDword "file options", &H30
    'set a master password
    SaveSetting "Dane Prairie Systems", "Win2PDF", "master password",
"abracadabra"
    'set the PDF document title
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFTitle", "Hello World
sample"
    'set landscape orientation
    Printer.Orientation = vbPRORLandscape
    'output some text
    Printer.Print "hello world!"
    Printer.Print "www.win2pdf.com"
    'save the PDF file
    Printer.EndDoc
End Sub

The following example demonstrates how to append to an existing PDF file.
Private Sub Command2_Click()
    'set the output file name to create original PDF file
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:\TEST.
PDF"
   
    'output some text
    Printer.Print "hello world!"
    'save the PDF file
    Printer.EndDoc
    
    
    'Append new text to original PDF file
    'assign original PDF file
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFAppendFile", "c:
\TEST.PDF"
    
    'set new output file to maintain the original PDF file
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\AppendedTest.PDF"
    
    Printer.Print "2nd page added"
    Printer.EndDoc

End Sub

5.3.1.2 Using the Win32 API
The Microsoft Knowledgebase article Q175535 has information on using the Win32 API
from Visual Basic.  The Win32 API can be used when the Printer object does not provide
the necessary functionality.

1. Create a Standard EXE project in Visual Basic 6.0. Form1 is created by default.
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2. Add 2 CommandButtons to Form1. 
3. Add the following code to the General Declarations section of Form1: 
  Option Explicit
   Private Const LF_FACESIZE = 32
   Private Type LOGFONT
      lfHeight As Long
      lfWidth As Long
      lfEscapement As Long
      lfOrientation As Long
      lfWeight As Long
      lfItalic As Byte
      lfUnderline As Byte
      lfStrikeOut As Byte
      lfCharSet As Byte
      lfOutPrecision As Byte
      lfClipPrecision As Byte
      lfQuality As Byte
      lfPitchAndFamily As Byte
      lfFaceName As String * LF_FACESIZE
   End Type
   Private Type DOCINFO
      cbSize As Long
      lpszDocName As String
      lpszOutput As String
      lpszDatatype As String
      fwType As Long
   End Type
   Private Declare Function CreateFontIndirect Lib "gdi32" Alias _
   "CreateFontIndirectA" (lpLogFont As LOGFONT) As Long
   Private Declare Function SelectObject Lib "gdi32" _
   (ByVal hdc As Long, ByVal hObject As Long) As Long
   Private Declare Function DeleteObject Lib "gdi32" _
   (ByVal hObject As Long) As Long
   Private Declare Function CreateDC Lib "gdi32" Alias "CreateDCA" _
   (ByVal lpDriverName As String, ByVal lpDeviceName As String, _
   ByVal lpOutput As Long, ByVal lpInitData As Long) As Long
   Private Declare Function DeleteDC Lib "gdi32" (ByVal hdc As Long) _
   As Long
   Private Declare Function TextOut Lib "gdi32" Alias "TextOutA" _
   (ByVal hdc As Long, ByVal x As Long, ByVal y As Long, _
   ByVal lpString As String, ByVal nCount As Long) As Long ' or Boolean
   Private Declare Function StartDoc Lib "gdi32" Alias "StartDocA" _
   (ByVal hdc As Long, lpdi As DOCINFO) As Long
   Private Declare Function EndDoc Lib "gdi32" (ByVal hdc As Long) _
   As Long
   Private Declare Function StartPage Lib "gdi32" (ByVal hdc As Long) _
   As Long
   Private Declare Function EndPage Lib "gdi32" (ByVal hdc As Long) _
   As Long
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   Const DESIREDFONTSIZE = 12     ' Could use variable, TextBox, etc.
   Private Sub Command1_Click()
   ' Combine API Calls with the Printer object
      Dim OutString As String
      Dim lf As LOGFONT
      Dim result As Long
      Dim hOldfont As Long
      Dim hPrintDc As Long
      Dim hFont As Long
      Printer.Print "Printer Object"
      hPrintDc = Printer.hdc
      OutString = "Hello World"
      lf.lfEscapement = 1800
      lf.lfHeight = (DESIREDFONTSIZE * -20) / Printer.TwipsPerPixelY
      hFont = CreateFontIndirect(lf)
      hOldfont = SelectObject(hPrintDc, hFont)
      result = TextOut(hPrintDc, 1000, 1000, OutString, Len(OutString))
      result = SelectObject(hPrintDc, hOldfont)
      result = DeleteObject(hFont)
      Printer.Print "xyz"
      Printer.EndDoc
   End Sub
   Private Sub Command2_Click()
   ' Print using API calls only
      Dim OutString As String  'String to be rotated
      Dim lf As LOGFONT        'Structure for setting up rotated font
      Dim temp As String       'Temp string var
      Dim result As Long       'Return value for calling API functions
      Dim hOldfont As Long     'Hold old font information
      Dim hPrintDc As Long     'Handle to printer dc
      Dim hFont As Long        'Handle to new Font
      Dim di As DOCINFO        'Structure for Print Document info
      OutString = "Hello World"   'Set string to be rotated
   ' Set rotation in tenths of a degree, i.e., 1800 = 180 degrees
      lf.lfEscapement = 1800
      lf.lfHeight = (DESIREDFONTSIZE * -20) / Printer.TwipsPerPixelY
      hFont = CreateFontIndirect(lf)  'Create the rotated font
      di.cbSize = 20                  ' Size of DOCINFO structure
      di.lpszDocName = "My Document" ' Set name of print job (Optional)
   ' Create a printer device context
      hPrintDc = CreateDC(Printer.DriverName, Printer.DeviceName, 0, 0)
      result = StartDoc(hPrintDc, di) 'Start a new print document
      result = StartPage(hPrintDc)    'Start a new page
   ' Select our rotated font structure and save previous font info
      hOldfont = SelectObject(hPrintDc, hFont)
   ' Send rotated text to printer, starting at location 1000, 1000
      result = TextOut(hPrintDc, 1000, 1000, OutString, Len(OutString))
   ' Reset font back to original, non-rotated
      result = SelectObject(hPrintDc, hOldfont)
   ' Send non-rotated text to printer at same page location
      result = TextOut(hPrintDc, 1000, 1000, OutString, Len(OutString))
      result = EndPage(hPrintDc)      'End the page
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      result = EndDoc(hPrintDc)       'End the print job
      result = DeleteDC(hPrintDc)     'Delete the printer device context
      result = DeleteObject(hFont)    'Delete the font object
   End Sub
   Private Sub Form_Load()
      Command1.Caption = "API with Printer object"
      Command2.Caption = "Pure API"
   End Sub
 
4.   Run the Project and click API with Printer object . This will print a single page to the
current default printer with "Printer Object" and "xyz" printed normally and "Hello
World" printed rotated 180 degrees. 
5.   Click Pure API . This will print a single page to the current default printer with
"Hello World" printed normally and rotated 180 degrees.

5.3.2 Crystal Reports
The following Visual C example shows how to print a document to Win2PDF using
Crystal Reports.
 
void CPrinting::PrintPDF(LPTSTR sPrintType, int iPrintMethod)
{

_TCHAR sFileName[PE_FILE_PATH_LEN] = "";
short hJob = 0;
PEPrintOptions  PrintOptions;
PEOpenEngine();
hJob = PEOpenPrintJob("d:\\pics32\\pics32\\live\\quote.rpt");
PrintOptions.StructSize     = PE_SIZEOF_PRINT_OPTIONS;
PrintOptions.startPageN     = 1;
PrintOptions.stopPageN      = -1;
PrintOptions.nReportCopies  = 1;
PrintOptions.collation      = PE_COLLATED;
_tcscpy(sFileName, "D:\\temp\\test.pdf");  // Here is the PDF file name
_tcscpy(PrintOptions.outputFileName, sFileName);
PESetPrintOptions(hJob, &PrintOptions);
PEOutputToPrinter(hJob, 1);
PEStartPrintJob(hJob, TRUE);
PECloseEngine();

}

The same example using Visual Basic follows.
Public Function printAPIReport(RptName As String, rptPath As String,
outPath As String) As Boolean
    Dim PrintOptions As PEPrintOptions 
    Dim hjob As Integer 
    PEOpenEngine()
    hjob = PEOpenPrintJob(rptPath & RptName)
    
    PrintOptions.StructSize = PE_SIZEOF_PRINT_OPTIONS
    PrintOptions.StartPageN = 1
    PrintOptions.stopPageN = -1
    PrintOptions.nReportCopies = 1
    PrintOptions.collation = PE_COLLATED
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    PrintOptions.outputFileName = "c:\\Temp\\TEST.PDF" & Chr(0)
        
    PESetPrintOptions(hjob, PrintOptions)
    
    PEOutputToPrinter(hjob, 1)
    
    PEStartPrintJob(hjob, True)
   
    PECloseEngine
End Function

5.3.3 Microsoft Access
The following example shows the basic code to open and print an Access report to
Win2PDF.  This example uses SaveSetting to set the PDF file name and will suppress
the Win2PDF File Save dialog.
Private Sub cmd_PrintToWin2PDF_Click()
'This code assumes that Win2PDF is set as the default printer.
On Error GoTo Err_cmd_PrintToWin2PDF_Click
    Dim stDocName As String
    
    'set the output file name
    SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:\AccessTest.
pdf"
 
    stDocName = "Report to be converted"
    DoCmd.OpenReport stDocName, acNormal
    
Exit_cmd_PrintToWin2PDF_Click:
    Exit Sub
Err_cmd_PrintToWin2PDF_Click:
    MsgBox Err.Description
    Resume Exit_cmd_PrintToWin2PDF_Click
    
End Sub
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6 Dane Prairie Systems Company Information

Information on Win2PDF is available at http://www.win2pdf.com
For help on our products, including technical support, send e-mail to support@win2pdf.
net
For sales inquiries, send e-mail to sales@win2pdf.com
Our fax number is (612) 435-4926. 
Our mailing address is:

Dane Prairie Systems, LLC
P.O. Box 24491
Minneapolis, MN 55424-0491
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